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In coming to Alaska, McCandless yearned to 

wander uncharted country, to find a blank spot 
on the map. In 1992, however, there were no 
more blank spots on the map |not in Alaska, 

not anywhere. But Chris, with his idiosyncratic 
logic, came up with an elegant solution to this 
dilemma: He simply got rid of the map. In his 

own mind, if nowhere else, the terra would 
thereby remain incognita 

 
Jonn Krakauer. Into the Wild. 

 
-Y no olvides llevar un mapa, pero _úsalo tan 

solo cuando sea realmente necesario. Como una 
bengala que no has de lanzar salvo en caso de 
emergencia, o como un antídoto que no debes 

tomar si no probaste veneno alguno. 
 

Ella se quedo mirando en silencio con cara de no 
entender nada. 

 
-El mapa te dirá donde estas -aclaro el-, y 

eso no es algo que un viajero deba saber antes de 
decidir volver a casa. 

 
Lucía Arganzúa. El alma que no tuve. 
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GLOSARIO 
 
 

Cantera: Sitio de donde se saca piedra, greda y otra sustancia análoga para obras 

varias (ESPAÑOLA, 2014). 
 
Escalonada: Geol. Estrato de gran espesor (ESPAÑOLA, 2014). 
 
Pendiente: 1. adj. Inclinado, en declive. Terreno pendiente.  
2.  f. Cuesta o declive de un terreno. 
3. Geom. Medida de la inclinación de una recta o de un plano. (ESPAÑOLA, 
2014). 
 
Ángulo del talud: es función de dos factores a. El tipo de roca características 

estructurales y resistentes de los materiales b. Altura de banco. 
 
Algebra de mapas: el conjunto de técnicas y procedimientos que, operando sobre 
una o varias capas en formato ráster, nos permite obtener información derivada, 
generalmente en forma de nuevas capas de datos y analizarlas. Sería más correcto 
hablar de un álgebra de capas ráster. 
 
Dimensión pixel: nos da la resolución espacial, que es la  capacidad del  sensor 

para discriminar el objeto más pequeño, normalmente especificado en términos 
lineales. 
 
Sistema ráster: se basan en establecer una retícula y almacenar atributos de  todas 

las celdillas. 
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RESUMEN 
 
 

Utilizando sistemas de información geográfica, se identificó el lindero de la cantera 
la estrella en el Municipio de Ricaurte, Departamento de Cundinamarca; de acuerdo 
al contrato para Mediana Minería con la respectiva proyección al sistema magna 
identificando la zona de estudio para la realización de la cartografía y análisis de 
taludes. 
 
Para llevar a cabo lo anterior, se compilo, organizó, analizó la información espacial 
de la cantera existente a la fecha, se verifico perímetro del predio intervenido por la 
actividad minera otorgada por el Ministerio de Minas y Energía y/o MINERCOL. 
 
Se realiza la edición del mapa geológico regional de la cantera, el mapa de las 
unidades geomorfológicas del municipio de Ricaurte en inmediaciones de la cantera 
la Estrella. Y el mapa de unidades litológicas dentro del área de concesión de la 
cantera. 
 
Haciendo uso de las herramientas de análisis espacial se sistematizaron los datos 
para obtener el mapa de pendientes (surface slope) y orientación de pendientes 
(surface aspect) para la estabilidad de taludes en la zona de cantera, se definieron 
las zonas con potencial inestabilidad natural y antrópica. 
 
Los Sistemas de Información Geográfica permiten combinar y cruzar información 
para obtener datos secundarios dando cualidades específicas al objeto de estudio, 
haciendo uso de las herramientas de geo-procesamiento con capas vectoriales se 
identificara las zonas más propicias para manejo de taludes. 
 

 
PALABRAS CLAVES: proyección, cantera, taludes, pendiente, minería. 
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ABSTRACT 
 
 

Abstract Using GIS, the edge of the quarry La Estrella in the municipality of Ricaurte, 
Cundinamarca Department identified; according to the contract for the respective 
medium mining magna projection system by identifying the study area to perform 
mapping and analysis of slopes. 
 
To accomplish this, it was necessary to compile, organize and analyze the spatial 
information of the existing quarry to date, perimeter of the property seized by mining 
granted by the Ministry of Mines and Energy or MINERCOL was verified.  
 
Editing the regional geological map of the quarry is done, the map of the 
geomorphological units of the municipality of Ricaurte in Vicinity of the quarry Star. 
And the map of lithological units within the concession area of the quarry.  
 
Using Spatial Analysis Tools for Data to get the slope map (mapa de pendientes) 
and slope orientation (orientación de pendientes) to slope stability in the quarry were 
systematized, Zones defined with potential instability and natural anthropic.  
 
The GIS allows combining and cross information to obtain secondary data giving the 
object of study specific qualities, making use of geo-processing tools vector layers 
with the most conducive to handling slope areas identified. 
 
 
KEY WORDS: projection, quarry, slopes, slope mining. 
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INTRODUCCIÓN 

 
El municipio de Ricaurte es uno de los 116 municipios que conforman el 
Departamento de Cundinamarca y uno de los ocho municipios que 
pertenecen a la provincia del Alto Magdalena. 
 
Las características geológicas y litológicas de la región, alberga 
importantes yacimientos mineros y energéticos, el plan de ordenamiento 
territorial (POT) los localiza en las veredas el Paso, Callejones y la Virginia; 
en este último se localiza la cantera la estrella. 
 
La explotación de los materiales en la cantera la Estrella, se desarrolla desde los 
años 80, con la extracción de recebos, utilizados en diversas actividades y obras 
civiles. Siempre la explotación realizada a pequeña escala.  
 
Las explotaciones inician manualmente sin un orden definido y sin el previo 
conocimiento de los sectores que pueden ser efectivamente explotados, el resultado 
es ambientalmente desastroso y un aprovechamiento marginal del yacimiento,  
posteriormente con equipos mecánicos de poca capacidad; pero con el crecimiento 
de la construcción urbana y vial de la región, se requirieron grandes volúmenes de 
materiales, que obligaron a ejercer extracción de materiales a gran escala, hasta el 
punto que la Corporación Autónoma existente tuvo que intervenir, para controlar que 
dichas explotaciones se desarrollaran dentro de un marco legal compatible con el 
medio ambiente. 
 
Los Sistemas de Información geográfica ofrecen herramientas capaces de 
combinar,  cruzar y analizar datos de información cartográfica con el fin de obtener 
datos secundarios como lo es el geo-procesamiento con capas vectoriales, 
localizando puntos estratégicos en este caso para el manejo de taludes basado en 
una metodología de análisis ráster. De esta manera los ráster cuyo pixel ofrecen un 
tipo de información que puede ser analizada como resultado de la combinación de 
varias capas. 
 
Para desarrollar lo anterior, se identifica la zona de trabajo con su entorno más 
cercano de acuerdo a las formaciones geológicas superficiales, se clasifico la 
información obtenida de la zona, elaborando los mapas temáticos (mapa topográfico 
del área, mapa geomorfológico y procesos superficiales, mapa geológico regional 
en inmediaciones a la cantera la estrella, mapa local del área de interés), se 
obtienen los mapas de pendientes y de orientación de pendientes para un análisis 
del manejo de taludes para su estabilidad tanto natural como antrópica en la cantera 
la estrella mostrando las diferencias minero ambientales entre explotación 
planificada y no planificada. 
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1. ÁREA PROBLEMÁTICA 

La extracción  de los materiales de la cantera la estrella se ha realizado sin 
una planeación o manejo de taludes adecuados, esto se ha desarroll ado de 
una manera casi empírica, con el tiempo han tratado de ir ajustándose a los 
requerimientos de las normas ambientales. 
 
La cantera la estrella trata de dar cumplimiento de materiales, a las obras 
civiles generadas en la región. Con la expansión urbana se ha requerido 
más material y esto ha generado la extracción sin tener un control de 
acuerdo al marco legal vigente. 
 
La falta de aplicación del modelo geotécnico presentado a la corporación autónoma 
y la explotación desmesurada ha generado inestabilidad en los taludes y ha logrado 
disminuir la vida útil de la cantera (Foto 1). 
 
El uso de los Sistemas de Información Geográfica permite hacer una organización 
de la información georreferenciada facilitando la localización de zona piloto para el 
manejo de taludes en la cantera la estrella. 
 
La continua observación de la evolución en el proceso de extracción del material, 
permite ahorrar valiosos recursos económicos, generar mayor producción, 
seguridad ocupacional y ante todo un aprovechamiento de la pendiente; el depósito 
de material se podría explotar en varias capas (bancos) simultáneamente. Al no 
llevarse un manejo técnico en la cantera la estrella, no se logran estos beneficios y 
termina por generarse un problema en la estabilización de taludes disminuyendo la 
vida útil de la misma. 

 

 
Foto 1. Fuente propia, Panorámica Cantera la estrella, municipio de Ricaurte Departamento de Cundinamarca. 
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2. OBJETIVOS 

 
 

2.1 OBJETIVO GENERAL 

 
 
Localizar áreas de potencial manejo de taludes en la cantera la estrella, 
mediante herramientas Sistemas de Información geográfica según el 
modelo geotécnico. 
 
 
2.2 OBJETIVOS ESPECÍFICOS 

 Realizar un levantamiento topográfico para obtener el relieve actual 
de la zona. 
 

 Cartografiar los mapas temáticos de unidades geomorfológicas, litológicas, 
estructuras geológicas  y procesos erosivos, en y las inmediaciones de la 
cantera La Estrella. 
 

 Identificar las zonas para sistema de banqueo, con el uso de 
herramientas SIG teniendo como parámetro la geotecnia. 
 

 Realizar el análisis ráster mediante un algebra de mapas haciendo 
uso de los Sistemas de Información Geográfica.  
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3. JUSTIFICACIÓN 

 
Considerando la demanda de materiales de cantera en la región, los cuales 
son prioritarios por su utilidad como agregados pétreos para la elaboración 
de concretos hidráulicos, mezclas asfálticas, Bases granulares, empleados 
en la construcción de elementos estructurales y de vías. 
 
Es allí cuando la producción de material de recebo en la cantera La Estrella 
exige incrementar su extracción para cumplir con la demanda, sin embargo, 
para la época no se ejecutaba un estricto control de estas actividades lo 
que desencadeno una serie de desaciertos en la extracción del recebo 
generando taludes inestables y daños al ecosistema  (Foto 2). Se genera la 
necesidad de buscar alternativas que permitan una adecuación de la 
cantera a condiciones que lleven con el cumplimiento de las normas 
ambientales. 
 

 
Foto 2.  Fuente propia, Imagen panorámica de la  zona de extracción de material en al  cantera. 

 
Con el propósito de recuperar las zonas afectadas y poder efectuar futuras 
explotaciones de las reservas existentes de recebo, para el año 2010 se 
propone por parte de los propietarios ante la CAR un plan de manejo 
ambiental para extraer el material de recebo el cual estuvo suspendido 
hasta el 2014 y fue reiniciado en el presente año con terminación en el año 
2016. En el mencionado plan se propuso un modelo Geotécnico para la 
estabilización y adecuación de taludes, sin embargo, en la actualidad, en 
algunos frentes de la explotación la inestabilidad de taludes son  
recurrentes, lo que permite a esta investigación es proponer un plan idóneo 
el cual responden a la interacción de las estructuras geológicas, con la cara 
libre del talud. 
 
La adecuación de sistemas de extracción de material permitirá hacer un 
manejo eficiente y productivo de la cantera la estrella acorde a las políticas 
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ambientales, de igual manera un manejo más eficiente de los recursos 
destinados a la extracción del material de recebo. 
 
Basado en álgebra de mapas, se desarrollara el proyecto en el que necesita 
identificar la localización más adecuada para iniciar la estabilización de 
taludes en la cantera. Con la combinación de diferentes capas cartográficas 
se conseguirá analizar información diversa e identificar las zonas. 
 
El fin último será presentar unos planos cartográficos los cuales están 
orientados a partir de los parámetros dados por la geotecnia y el uso de 
suelos de las zonas geográficamente potenciales para iniciar la extracción 
de material. 
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4. MARCO TEÓRICO 

 
 

4.1 Los SIG y la Topografía. 

 
Los sistemas de información como sistemas de control no actúan solos, se valen de 
diferentes disciplinas que permiten hacer una recolección de los datos geo-
referenciado de acuerdo al trabajo a realizar.  
 
Es la topografía (geomática) herramienta principal en la recolección de información 
física de la tierra mostrando la condición actual, representando gráficamente el 
relieve, realiza la localización de objetos en el espacio. El almacenamiento de esta 
información realizada de manera concienzuda y de alta calidad lleva a obtener un 
análisis más preciso frente al objeto de estudio en la administración de las 
herramientas SIG. 
 
La realización de diferentes levantamientos de un objetos de estudio a través del 
tiempo pueden revelar los cambios no solo del relieve, también pueden dar cuenta 
de cambios ambientales, sociales y de expansión  urbana, rural, o impacto de los 
seres humanos sobre el entorno, como también se puede observar impactos de la 
naturaleza frente a la sociedad generando desplazamientos o cambios en las 
actividades de subsistencia, desplazamiento y demás actividades cotidianas. 
 
Algunos autores expresan “La clave para la operación exitosa de los sistemas de 
información geográfica radica en datos espacialmente relacionados de alta calidad, 
y la recolección y el procesamiento de estos datos ha impuesto nuevas y grandes 
demandas sobre la comunidad de la topografía” (WOLF Paul R., 2009). 
 
Con la evolución de la tecnología la recopilación de datos se hace por medio de 
instrumentos electrónicos (estación total, niveles de precisión, GNSS, calculadoras) 
los cuales procesan los datos internamente y dan información en tiempo real no solo 
de la ubicación espacial sino de distancias, angulos pendientes sobre el terreno; los 
datos obtenidos no solo de la tierra sino del objeto de estudio espacialmente, esta 
representación se vera reflejada en los tipos de mapas generados. 
  
4.2 Los SIG y la Cartografía 

 
Los mapas son la representación de los datos según el propósito, sea topográfico 
temático o general. Los SIG han llevado el uso de los mapas al análisis espacial 
(Los datos espaciales, algunas veces llamados también datos gráficos, consisten 
en generar aspectos naturales y culturales que pueden mostrarse con líneas o 
símbolos en mapas).  
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Según la Asociación Cartográfica Internacional un mapa es “la representación 
convencional gráfica de fenómenos concretos o abstractos, localizados en la Tierra 
o en cualquier parte del Universo” (FOMENTO) 
 
El propósito del mapa topográfico al representar gráficamente los elementos de la 
tierra no se queda en esto; pues es la herramienta principal para la elaboración de 
los mapas temáticos, análisis espacial sea mapas de pequeña o gran escala. La 
correcta información de campo depende de la pericia del especialista SIG en 
transmitir la información requerida y los puntos de amarre geodésico en la toma de 
datos, se trabaja de manera interdisciplinaria con la topografía. 
 
Los mapas se han venido posicionando en una herramienta importante para 
analizar, interpretar, diseñar, almacenar, analizar datos, con los SIG se relacionan 
estos datos para dar solución a problemas, facilitar la toma de decisiones en 
diferentes áreas, tener un SIG es no solo una alternativa para mejorar el trabajo, es 
también una alternativa para plantear soluciones en diferentes áreas.  
 
La elaboración cartográfica requiere el uso de diversos software, para el 
procesamiento de la información, para la descarga de imágenes satelitales 
programas como el SAS planet, Google Earth Pro; Proyección de Coordenadas con 
el Magna Sirgas Pro 3. Instituto Geográfico Agustín Codazzi. Subdirección de 
Geográfia y Cartografía. Software de dibujo como AutoCAD Civil 3d “El CAD puede 
resultar suficiente para desarrollar algunas tareas propias de los SIG, en particular 
las relacionadas con el diseño cartográfico” (Víctor, 2011), en Sofware SIG ArcGIS, 
adecuados para la realización del trabajo y poder realizar el análisis de los datos. 
 
4.3 Los SIG y la geología. 

 
El trabajo en cualquier excavación a realizar, es necesario el conocimiento del 
estado tensional natural del macizo rocoso para realizar un análisis de tensiones así 
“El conocimiento más o menos exacto del estado tensional permitirá responder 
cuestiones básicas como: ¿De qué efectos tensionales se debe proteger la obra 
que se va a realizar?, ¿En qué dirección va a tender a romperse la roca?, ¿Cuál 
sería la forma ideal del hueco minero?” (RAMÍREZ OYANGUREN, Septiembre 09 
2004) 
 
4.4 ANTECEDENTES 

 

Este fue un trabajo interdisciplinario para optar a los títulos de especialistas, desde 
la geotecnia NIETO LAGUNA, Carlos Andrés & VINASCO LARGO, José 
Verificación del modelo geotécnico propuesto para la estabilización de los taludes 
generados en la cantera la estrella localizada en el municipio de Ricaurte 
Departamento de Cundinamarca. Manizales 2015, 90 p. Trabajo realizado para 
optar al título de (Especialización en Geotecnia). Universidad de Caldas, Facultad 
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de Ciencias Exactas y Naturales, Especialización en Geotecnia. Luis y desde el 
trabajo del SIG Jorge Iván Carmona Chica. 
 
SER_VIDA LTDA.ABRAHAM CRUZ HUERTAS Ing. Ambiental  Especialista 
Gestión Ambiental Alfonso Lazo Beltrán Ing. Geólogo Msc. Ingeniería – Geotecnia  
realizaron un documento complemento al P.M.A. contrato mediana minería 18758, 
Complemento plan de manejo ambiental y geológico el 28 de mayo de 2010 en la 
cantera la estrella.  
 
 
En Quito Perú, Pifo es una Cantera de Agregados para la construcción próxima a la 
ciudad de Quito, por lo que se encuentra cerca de un mercado grande que requiere 
una gran demanda de agregados y áridos de calidad. En el año 2005 la Cantera 
vendió 450.000 toneladas de áridos. En la tesis de grado Metodología de 
planificación minera a corto plazo y diseño minero a mediano plazo en la cantera 
pifo (Eduardo Recalde, 2005), hace uso de las herramientas SIG como es ArcView 
3.2. Gestor de que crea o integra datos alfanuméricos con vectoriales procedentes 
de una imagen y gráficos CAD, sin realizar análisis de los datos tomados. 
 
 
En Colombia, el programa de aprovechamiento sostenible de minerales (PASM) en 
la Sabana de Bogotá mediante procesos de planificación integrada, Diagnostico 
basado en el análisis de temas claves, Bogotá, D.C. 19 de diciembre de 2006, este 
programa surge a partir de la revisión por parte de los participantes a un taller inicial 
realizado en el mes de Septiembre, en donde el grupo consultor presentó de forma 
preliminar 36 temas de la sostenibilidad de la minería en la Sabana de Bogotá. 
Adicionalmente, se debe mencionar que en el Distrito Capital existe riesgos latentes 
que corren las comunidades localizadas en los barrios adyacentes a la zona de 
canteras ubicadas en la localidad del Tunjuelo, relacionados con la susceptibilidad 
del terreno a los fenómenos de remoción en masa e inundaciones, derivados del 
deterioro ambiental histórico y de los eventos de inundaciones ocurridos en el años 
2002 (Energética, 2006). Los SIG serán una herramienta propicia para el análisis 
de la información recopilada.  
 
Se pudo observar pocas o ninguna fuente bibliográfica que de referencia de trabajos 
en canteras usando sistemas de Información Geográfica. 
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5. METODOLOGÍA 

 
 

5.1 TIPO DE TRABAJO 

 
En este proyecto se aplica un método descriptivo, investigación aplicada al campo 
de la minería  a cielo abierto en la cantera la estrella ubicada en el municipio de 
Ricaurte, Departamento de Cundinamarca.  
 
Este trabajo desarrolla el método exploratorio, permitiendo obtener información 
sobre las áreas acordes para extracción de material y adecuación de taludes, a 
partir de esta información se puede adecuar el modelo geotécnico en la cantera. 
 
“Los píxel1 coincidentes de cada capa, se solapan para aportar sus valores y 
generar, como resultado, una nueva capa ráster cuyos valores son fruto del análisis 
de valores de píxeles iniciales. Esta combinación se puede realizar en base a 
sencillas condiciones matemáticas como las sumas” (Ferreras, 31 de julio de 2014) 
 
Este es un trabajo interdisciplinario en el cual fue necesario la topografía, la 
geotecnia (VINASCO LARGO & NIETO LAGUNA, 2016) los cuales dan aportes en 
la parte geologica. 
 
Con el uso de ArcGIS y sus extensiones Arcmap realiza el diseño de capas Shape 
file, para la cantera la estrella las cuales evidencian las pendientes(slope), 
orientación de pendientes (aspecto), zonas deslizamiento, zonas antropicas, zonas 
naturales. Para luego cruzar y combinar esta información en los procesos de algebra 
de mapas. Identificando zonas geográficas específicas develando atributos 
concretos para el manejo de taludes (zonas de banqueo). 
 
 
5.2 PROCEDIMIENTO 

 
Con la combinación de nuestras capas ráster  obtenemos un ráster donde, cada 
pixel, presenta un valor específico que nos puede ayudar a identificar zonas 
estratégicas con el fin de dar respuesta a nuestras necesidades de estabilizar 
taludes. 
 
Criterios para el análisis de las capas ráster en la estabilización de taludes. 

 Resolución de 2x2 en el píxel con el fin de precisar el objeto de estudio. 

 Todas las capas presentan la misma resolución de pixel para dar 
homogeneidad y compararse entre sí. 

                                                
1 Acrónimo de picture element 



 

23 

 

 Todas las capas están en su correspondiente proyección de manera 
homóloga. 

 Las zonas territoriales presentan la misma extensión. Dando como resultado 
coincidencia espacial. 

 
La herramienta para el análisis de nuestra cartografía ráster será  Raster Calculator, 
junto a otras herramientas propias del análisis y gestión de archivos ráster. 
 
 
5.2.1. Recopilación datos primarios.  
Búsqueda dirigida a recopilar información cartográfica del título minero y 
topografía de la zona de estudio. 
 

Datos Generales de la Actividad. 
Nombre.  María Idali Tafur Salazar & otro 
Cédula.  39.568.377 Girardot 
Dirección.  Cantera la Estrella Vereda la Virginia 
Municipio.  Ricaurte 
Vereda.  La Virginia 
Teléfono Móvil.  310 344 6052 
Correo Electrónico. Idalitafur@gmail.com 
Notificación.  Cantera la Estrella Vereda la Virginia 
Año de Inscripción del contrato.   El contrato de concesión fue inscrito 

en el Registro Minero Nacional el 
10/05/2006 

Servicios públicos.  Agua, Luz. 
 
 
La información cartográfica de partida es planos en formato dwg. (AutoCAD) 
facilitada por la administración de la cantera. 
 
Anexo A.  Topográfico. dwg. La estrella noviembre_2005 
Anexo B.  Topográfico 09. Estrella octubre_2009 
Anexo C.  Restauración morfológica. Estrella abril_2010_ 
Anexo D.  Municipio de Ricaurte. dwg. estrella 
 

5.2.1.2. Localización del área de estudio. 

 
El predio intervenido por la actividad minera, se ubica al sur-oriente de la cabecera 
municipal del Municipio de Ricaurte, sector denominado El Paso, una altura 
aproximada 373 msnm  (Figura 1). 
 

mailto:Idalitafur@gmail.com
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Figura 1.

 
Área otorgada por el Ministerios de Minas y Energía y/o MINERCOL, la plancha 
topográfica que refiere el plano en el Instituto Geográfico Agustín Codazzi Plancha 
IGAC 1:10000 245 – IV – D – 3, El predio comprende una superficie de 9 hectáreas, 
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5.2.1.3. Trámites surtidos ante la Autoridad minera (Min-minas, MINERCOL e 
INGEOMINAS). 
 

El Ministerio de Minas y Energía mediante la Resolución No 701080 del 28 de 
Agosto de 1998, Otorgó la Licencia de Explotación No 18758 al señor Luis Alberto 
Tafur Navarro, para la explotación de un yacimiento de arenisca. 
 
Dicha licencia de explotación fue inscrita en el Registro Minero Nacional el 24 de 
Julio de 2001. 
 
El titular de la Licencia de Explotación No. 18758. El señor LUIS ALBERTO TAFUR 
NAVARRO, mediante el oficio radicado el 16 de diciembre de 2002 ante las Oficinas 
de la Empresa Nacional Minera MINERCOL LTDA., solicitó la conversión de la 
Licencia de pequeña minería a Contrato de Concesión, debido a que el volumen 
promedio de explotación que requiere asciende a 15000 m3/año.      
 
Mediante la Resolución No 10900262 del 15 de octubre del 2003, MINERCOL 
LTDA. Autorizó la cesión del 100% de derechos y/u obligaciones mineras que se 
derivan de la Licencia de la Explotación No 18758 a favor de la Señora MARÍA IDALI 
TAFUR SALAZAR. (LAZO BELTRÁN, 28 agosto 2010) 
 

Su perímetro de acuerdo al Contrato para Mediana Minería esta demarcado en la 
(Tabla 01). 
 

 ORIGEN BOGOTA ORIGEN MAGNA - SIRGAS 

 Gauss Krueger Elipsoidal 

Punto Norte Este Norte  Este 

1 962149 926300 4°15'13.07923" 74°44'29.02492" 

2 962449 926300 4°15'22.84515" 74°44'29.03281" 

3 962449 926600 4°15'22.85323" 74°44'19.30499" 

4 962149 926600 4°15'13.08749" 74°44'19.29717" 

Tabla 1. Coordenadas de Localización Cantera la Estrella.  

 
 

5.2.2. Levantamiento Topográfico. 
 

En Vista a la desactualización de los levantamientos topográficos presentados en 
de la zona de estudio, se opta por realizar un levantamiento topográfico amarrado 
a la red geodésica nacional y hacer una grilla de puntos dando detalle de la cantera 
en la zona de extracción de material, para tener un reconocimiento del relieve actual; 
permitiendo hacer un análisis y desarrollo de los elementos necesarios para la 
elaboración de los mapas topográficos y cartográficos. la recopilación de datos se 
hace por medio de instrumentos electrónicos (estación total, niveles de precisión, 
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GNSS, calculadoras cassio 9860 GII SD). Dando como resultado un plano en 
AutoCAD Civil 3d en noviembre de 2015 (Figura 2). 
Anexo E. cantera_estrella_tamaño _0.7x0.5. 
 

 
Figura 2. Fuente propia, levantamiento realizado en noviembre de 2015 cantera la estrella. 

 
5.3. Procesamiento de archivos .shp en Arcmap. 

 
La información se trabaja en el siguiente sistema de Coordenadas 
 
Datos geodésicos MAGNA Colombia Bogotá 
WKID: 3116 Authority: EPSG 
 
Projection: Transverse_Mercator 
False_Easting: 1000000.0 
False_Northing: 1000000.0 
Central_Meridian: -74.07750791666666 
Scale_Factor: 1.0 
Latitude_Of_Origin: 4.596200416666666 
Linear Unit: Meter (1.0) 
 

Importar archivo desde CAD a ArcGIS. 

Archivo proveniente de diseño asistido por computador extensión dwg. 

 
Creación: feature curvas.shp  
Ruta: 

- ArcMap → Add Data → estrella.dwg → add. 
- Click derecho archivo polygono → Data → Export Data. 
-  Export: Selected features → this layer’s source data. 
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- Output feature class: curvas → save → yes. 
Tipo: Polylinea. 
Descripción: Importar archivos desde AutoCAD CV 3D  a ArcGIS. 
Proyección: Magna_Colombia_Bogotá. 
Archivo: curvas_f_Clip.shp 

 
 
Este archivo nos sirve de base para generar el archivo ráster MDE (Figura 3). El 
cual corresponde a un archivo ráster descriptivo de los valores de altitud de la 
cantera. El tamaño de píxel es de 2x2, es decir, su resolución es de 2 metros.  
  

 
Figura 3. Fuente propia, importación de archivo CAD a ArcGIS 

 
Descarga de imágenes satelitales. 

 
Puntos de los vértices (Figura 4) descargados de Google Earth Pro. 
 
Agrego una marca de posición para las cuatro coordenadas de localización del 
proyecto en sistema de referencia WGS84 
 

 Creación: Kml y Kmz en Google Earth Pro 
Ruta: 

- Google Earth Pro → Mis Lugares (Click Der) → Añadir → carpeta → vértices. 
- Arrastrar las marcas de posición → a carpeta vértices → Click Der → Guardar 

como → vértices (kml – kmz). 
Tipo: punto 
Descripción: Contiene información sobre los vértices de la concesión minera 
Proyección: WGS84. 
Archivo: vértices 

 
 
Creación Shape file: vertice.shp 
Ruta: 
- ArcMap → ArcToolbox → Conversión Tools → From Kml → Kml to layer. 
- Input Kml file → vértice. 
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- Output Location → carpeta punto vértice. 
- Output Data Name → vértice. 

Tipo: punto. 
Descripción: Contiene información sobre los vértices de la concesión minera 
Proyección: Magna_Colombia_Bogotá. 
Archivo: vértices 

 

 
Figura 4. Fuentes propia,  vértices de la cantera la estrella. 

 
Capturar imagen satelital Google Earth Pro (Figura 5) a ArcGIS:  
Ruta:   
- Google Earth Pro → Guardar → Guardar Imagen → imagen jpg. 
- ArcMap → Add Data → imagen jpg → georeferencing →  fit to display → add 

control point → cuatro puntos de control.  
- Click derecho sobre la imagen → Data → Export Data → Cant_1.img 
- Output Data Name → vértice. 

Tipo: imagen jpg. 
Descripción: imagen referenciada de Google Earth Pro en ArcGIS. 
Archivo: cant_1.img 
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Figura 5. Fuente Google Earth Pro, Imagen referenciada en ArcGIS. 

 

Máscara sobre la geología local (perímetro cantera la estrella). 

Recortar parte de la imagen para focalizar el trabajo en la zona de la concesión de 
la cantera, para esto excluiremos la información de la zona de concesión con un 
efecto de transparencia (Figura 6). 
 
a. Descripción: creamos una nueva capa de tipo polígono, en la cual se extiende 

más de nuestra área de trabajo. 
Catalogo → New → Shapefile  

 Name: base 

 Feaature type: Polígono 

 Edit: (Sistema de proyección) Magna Colombia Bogotá 

 Ok 
 
b. Editar la capa base. 
Descripción: hacemos el rectángulo determina nuestra mayor área de trabajo. 
Editor → Start Editing → base → Rectangulo → Stop Editing → yes. 
 
c. Excluir la zona de trabajo. 
Descripción: esta herramienta nos ayuda a borrar elementos dentro de una capa 

siguiendo los límites dentro de otra capa; se utiliza para dar más realce a nuestra 
zona de trabajo sin excluir el resto del relieve. 

 
ArcToolbox → Analysis Tools → Overlay → Erase  

 Input Features: Base 

 Erase Features: pol_cant 

 Output Feature Class: mascara_can 
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Figura 6. Fuente propia, Mascara (herramienta de extracción) sobre la imagen de Google Earth Pro 

 

Recortar Shape para análisis de datos. 

 
Creación: shape de curvas dentro del perímetro de concesión.  
Ruta:  
- ArcMap → click der shape curvas → Data  → Export Data. 
- Export → All features → this layer’s source data 

Output feature class → cuvas2 → Ok. 
Tipo: Polylinea. 
Descripción: recortar shape file de curvas 
Proyección: Magna_Colombia_Bogotá 
Archivo: curvas_f_Clip.shp 

 
 

Recortar Shape para análisis de datos. 
 
Creación: Generación surface, modelo de elevación.  

Ruta:  

- ArcMap → Toolboxes → 3D Analyst Tools  → Raster Interpolation → Topo to 
Raster. 

- Input feature data → curvas.shp  
Output surface raster → surface.shp 
Output cell size → 1 → ok 

Tipo: modelo raster de elevación 
Descripción: Generación de superficie en ArcGIS a partir de curvas de nivel. 
Proyección: Magna Colombia Bogotá. 
Archivo: surface_f.shp 
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Generar Surface Slope (Pendientes). 

 
Se genera el modelo de pendientes desde la superficie ráster. 
Pendiente (P), inclinación del terreno (de una línea) con respecto a la horizontal; se 
indica en porcentaje (%) o como una magnitud angular (Cleves, 2007).  
 
La pendiente (slope) se puede presentar en porcentajes  o en grados. 
 

Pendiente (P) en Porcentaje, Desnivel2, multiplicado por cien. (un ángulo de 45° 
corresponde a una pendiente 100%). 
 

 

𝑝𝑜𝑟𝑐𝑒𝑛𝑡𝑎𝑗𝑒 =
𝑦 (𝐷𝑒𝑠𝑛𝑖𝑣𝑒𝑙)

𝑥 (𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑖𝑎)
∗ 100 

 

Pendiente en Grados, La expresión Tan-1 de lo que se asciende frente a lo que se 
recorre horizontalmente corresponde al ángulo cuando queremos expresar la 
pendiente en grados. 

 

á𝑛𝑔𝑢𝑙𝑜(∝) = 𝑡𝑎𝑛−1 (𝐴𝑟𝑐 𝑇𝑎𝑛) (
𝑦 (𝐷𝑒𝑠𝑛𝑖𝑣𝑒𝑙)

𝑥 (𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑖𝑎)
) 

 

De acuerdo a las gráficas de sectorización cinemática de estabilidad, los taludes 

propuestos no deberán tener inclinaciones superiores a 65º hacia el norte o sur, ya 

que podrían presentar fallas por volteo y planar debido a la presencia de 

las  Familias 1 y 2 respectivamente. 

Al analizar la capa de pendientes y tratar de identificar las zonas más llanas y 
pendientes de la cantera.  Correspondiente a un archivo ráster descriptivo de los 
valores de altitud cuyo tamaño de píxel es de 2x2, es decir, su  resolución es de 2 
metros. Este  valor se considera clave para trabajar en nuestro análisis  de manera 
que todos los archivos ráster que se manejan tendrán esta resolución. 
Para el modelo de análisis se utiliza un archivo ráster basado en una pendiente 
medida en grados sexagesimales (°). 
 
 
Creación: Generación slope, pendientes.  
Ruta:  
- ArcMap → Toolboxes → 3D Analyst Tools  → Raster surface → slope. 
- Input feature data → surface.shp  

Output surface raster → surface.shp 
Output cell size → 1 → ok 

                                                
2 haciendo referencia  distancia vertical o diferencia de nivel entre dos puntos 
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Tipo: modelo raster de elevación 
Descripción: Generación de modelo de pendientes a partir de surface. 
Proyección: Magna Colombia Bogotá. 
Archivo: slope.shp 
 

 
Figura 7. Fuente Propia, Generación modelo de pendiente, capa slope.shp 

 
El resultado es nuevo ráster (Figura 7)de colores en función de la tonalidad, 
representa un grado de pendiente. Las zonas rojas serán aquellas que disponga de 
una pendiente más pronunciada por lo que corresponderán a zonas donde las 
curvas de nivel se aproximan en intervalos de espacio muy estrechos. Las zonas 
verdes son de menor pendiente y terrenos más llanos. 
 
Como se puede observar en el slope, existe pendientes que trascurren desde 0° a 
74.2° (Figura 8), este proceso ahora nos sirve para clasificar las pendientes de 
acuerdo al análisis cinemático3 para identificar los lugares más apropiados en el 
manejo de taludes. 

                                                
3 El Análisis cinemático definido por Piteau y Peckover, 1978 se basa en el análisis estereográfico 
de la fábrica estructural, con el fin de  determinar las orientaciones de corte desfavorables para 
generar deslizamientos  de tipo planar y/o diedricos por cuñas o volcamientos; Mientras el análisis 
mediante el método de equilibrio limite se fundamente en la obtención del factor de seguridad que 
no es más que la comparación de  las fuerzas resistentes  contra las fuerzas causantes de la falla 
del talud. 
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Figura 8. Fuente propia, Simbología de la capa slope (pendientes) 

 

Generar Surface Aspecto (Orientación de pendientes). 
 

De acuerdo a las gráficas de sectorización cinemática de estabilidad, los taludes 

propuestos no deberán tener orientaciones en el rumbo entre N 55º W y N 65º E.  

Con inclinaciones superiores a 65º hacia el norte o sur, ya que podrían presentar 

fallas por volteo y planar debido a la presencia de las  Familias 1 y 2 

respectivamente. 

El ángulo agudo que la dirección Norte-Sur forma con la alineación dada se 

denomina Rumbo (α)” (Matera, 2002) 

Al analizar la capa de orientación de pendientes y tratar de identificar las zonas de  
escorrentía donde ofrece  mayor o menor orientación respecto al norte geográfico.  
El archivo ráster descriptivo de los valores de orientación de pendientes cuyo 
tamaño de píxel es de 2x2, es decir, su  resolución es de 2 metros. Este  valor se 
considera clave para trabajar en nuestro análisis  de manera que todos los archivos 
ráster que se manejan tendrán esta resolución. 
 
Para el modelo de análisis se utiliza un archivo ráster basado en una orientación 
medida en grados sexagesimales (0° a 360°). La dirección de una alineación 
cualquiera se puede definir por el ángulo horizontal (medido en sentido  horario), 
que dicha alineación forma con una alineación de referencia. Si la alineación de 
referencia es el eje norte, el ángulo horizontal se denomina acimut (ᵩ) (Matera, 2002) 
 
Creación: Generación aspecto, orientación pendientes.  
Ruta:  

- ArcMap → Toolboxes → 3D Analyst Tools  → Raster surface → aspect. 
- Input feature data → surface.shp  

Output surface raster → aspecto.shp 
Output cell size → 1 → ok 

Tipo: modelo raster de elevación 
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Descripción: Generación de orientación de pendientes en ArcGIS a partir de 

surface. 
Proyección: Magna Colombia Bogotá. 
Archivo: aspecto.shp 
 

 

Figura 9. Fuente propia, Generación modelo orientación de pendientes, capa aspecto.shp 

 

El resultado es un nuevo ráster de colores que en función de la tonalidad (Figura 9), 
representa una orientación de pendiente. Las zonas rojas serán aquellas que 
disponga de una orientación más al norte, las zonas cyan están más orientadas al 
sur. 
Como se puede observar, existe orientaciones de pendientes que trascurren desde 
0° a 365° (Figura 10), este proceso clasifica las orientaciones de pendientes de 
acuerdo al análisis cinemático para identificar los lugares más apropiados en el 
manejo de taludes. 
 

 
Figura 10. Fuente propia, Simbología de la capa aspecto (orientación de pendientes) 
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Generar reclasificación ráster slope. 
 
“El tipo de rotura presentado en los taludes 1 y 2, aplicado para las familias de 
diaclasas D3, D4 y D5 y para las familias de fallas F1 y F2 (Figura 11) , lo que 
sugiere rumbos de taludes críticos desde N60E a N30W buzando hacia el NW como 
hacia el NE, con ángulo de buzamientos mayores de 65° grados”. (VINASCO 

LARGO & NIETO LAGUNA), 

 

 
      

Figura 11. Fuente (VINASCO LARGO & NIETO LAGUNA),Análisis cinemático para roptura planar presente en 

el talud 1 delineado en color verde, y en rosado la zona crítica de falla.  (B) Análisis cinemático para rotura 
planar presente en el talud 2  delineado en  color verde, y en rosado la zona crítica de falla. En naranja es el 
rando  +/-  20° de paralelismo para que cumpla la condición. 

 

Para las pendientes en necesario recurrir a pendientes que no superen 65°. De esta 
forma se selecciona tres intervalos clasificando los valores así: 
 
Pendientes entre 0°  a  45° serán los  más aptos presentando una puntuación de 3 
puntos. 
Las pendientes entre 45°  a  65° serán menos idóneas presentando una puntuación 
de 2 puntos. 
Las  pendientes entre 65°  a  > no serán idóneas presentando una puntuación de 1 
puntos. 
 
Creación: Generación slope, pendientes.  
Ruta:  

- ArcMap → Toolboxes → Spatial Analyst Tools  → Reclass → Reclassify. 
- Input raster→ slope.shp  

Output surface raster → pen_reclass.shp 
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Puntuación  Pendiente 
3   0° a  45° 
2   45° a 65° 
1   65° a > 

 
Tipo: modelo raster  
Descripción: generar una puntuación de acuerdo a las pendientes que muestra 

desde la geotecnia como las adecuadas para trabajar taludes. 
Proyección: Magna Transverse Mercartor. 
Archivo: slope_rec.shp 

 

 
Figura 12. Fuente propia, reclasificación de la capa slope de acuerdo a los análisis geotécnicos. 

 
Con la herramienta reclassify nos permite reagrupar los valores de slope 
(pendientes) y asignarles el nuevo valor de pixel (Figura 12) que coincidirá con el 
valor de aptitud deseado para cada intervalo. 
 
 
Generar reclasificación ráster aspecto. 
 
Para la orientación de  taludes es necesario recurrir a rumbos que no superen desde 
N60E a N30W. (VINASCO LARGO & NIETO LAGUNA), De esta forma: 
 
Orientación entre 0° a 60° serán los  menos aptos presentando una puntuación de 
1 puntos. 
Orientación entre 325° a 360° también estará entre los menos idóneos presentando 
una puntuación de 1 puntos. 
Orientación entre 60° a 325° será  la orientación más idónea presentando una 
puntuación de 3 puntos. 
 
 
Creación: Generación reclasificación aspecto, orientación pendientes.  
Ruta:  

- ArcMap → Toolboxes → Spatial Analyst Tools  → Reclass → Reclassify. 
- Input raster→ aspecto.shp  
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Output surface raster → aspec_rec.shp 
 
Puntuación  Azimut 

1   0° a  60° 
1   325° a 360° 
3   60° a 325° 

 
Tipo: modelo raster  
Descripción: generar una puntuación de acuerdo a las orientacion que muestra 

desde la geotecnia como las adecuadas para trabajar taludes. 
Proyección: Magna Transverse Mercartor. 
Archivo: aspec_rec.shp 

 

 
Figura 13. Fuentes propia, reclasificación de la capa aspecto de acuerdo a los análisis geotécnicos. 

 
Con la herramienta reclassify nos permite reagrupar los valores de aspec 
(orientación de pendientes) y asignarles el nuevo valor de pixel (Figura 13) que 
coincidirá con el valor de aptitud deseado para cada intervalo. 
 
 
Algebra de Mapas de capas raster. 

 
Se entiende por álgebra de mapas el conjunto de técnicas y procedimientos que, 
operando sobre una o varias capas en formato ráster, nos permite obtener 
información derivada, generalmente en forma de nuevas capas de datos. Pues 
estas, por su estructura regular y sus características inherentes, son mucho más 
adecuadas para plantear los algoritmos y formulaciones correspondientes (Víctor 
Olaya, 2011). 
 
En esta capa se realiza el análisis conjunto de las dos variables (slope_rec.shp, 
aspec_rec.shp) con el fin de obtener la zona más apropiada ayudada de la 
herramienta de álgebra de mapas. 
 
El perímetro de una entidad geográfica estará compuesto por líneas horizontales o 
verticales exclusivamente y, además su longitud y la superficie que encierra serán 
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respectivamente múltiplos del tamaño de celda y el área de dicha celda (Víctor 
Olaya, 2011). 
 
En los análisis anteriores se han creado 2 capas ráster (slope_rec.shp, 

aspec_rec.shp) con una resolución igual entre ellas. Esta resolución mostraba pixels 

de 2x2 metros por lo que las capas generadas presentan unas dimensiones que nos 

ayudarán a comparar y combinar sus valores de manera coherente.  

Las capas bases en el análisis de álgebra de mapas son: 

slope, pendientes:    slope_rec.shp 

aspecto, orientación pendientes:  aspec_rec.shp 

Se combinaran las dos capas con el fin de que nuestros píxels sean sumados y 

obtener, así las zonas más idóneas para  adecuación de taludes (Figura 14). 

Esta capa generada es la responsable de mostrar los valores más aptos o menos 

aptos en la cantera, y poder así determinar las zonas estratégicas donde empezar 

a realizar un adecuado manejo de taludes según la geotecnia.  

 
Creación: Algebra de mapas.  
Ruta:  

- ArcMap → Toolboxes → Spatial Analyst Tools  → Map algebra → Raster 
Calculator. 

- Input raster→ aspcec_rec + slope_rec  
Output surface raster → sol_pend.shp 

Tipo: modelo raster de elevación 
Descripción: combinar las dos capas con el fin que nuestros pixeles sean sumados 

y obtener, así, las zonas más propicias para iniciar la adecuación de taludes. Las 
zonas donde los valores de pixeles sean máximo. 
Proyección: Magna Transverse Mercartor. 
Archivo: solución_1.shp 

 

 
Figura 14. Fuente propia, algebra de mapas de las capas de slope_rec y aspec_rec para generar la capa solución 1, 
siguiendo los parámetros geotécnicos. 
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Este nuevo archivo ráster  (Figura 15) con un degradado de píxeles que oscila entre 

2 y 6 clasifica el territorio mediante unidades de valor potencial para la estabilidad 

de taludes. 

 

 

Figura 15, Fuente propia, combinación de archivos slope rec y aspec rec, y el nuevo archivo ráster con un degradado de 
píxel que oscila entre 2 y 6 clasifica la cantera mediante unidades de valor potencial para adecuación de taludes. 

 

Aquellas zonas donde los valores de píxeles de cada variable sean igual a 3, y se 

solapen, generarán como resultado un nuevo píxel con valor igual a 6. 

En este caso, el máximo valor que puede adoptar un píxel es de 6, resultado de la 

combinación de aptitud de pendientes (3) y orientación de pendientes (3) con sus 

valores máximos. Se observa de manera más clara los potenciales lugares donde 

se puede adecuar los taludes empezando a trabajar por los lugares referenciados 

con valores más altos y así sucesivamente; en este caso se deben iniciar labores 

en sitios generados con 6 puntos y tomar también aquellos que se encuentran con 

5 puntos para adecuar los taludes de acuerdo a los requerimientos y  dando 

cumplimiento a los parámetros de geotecnia.  

 
 
Conversión de polígonos a ráster y reclasificación de las zonas naturales. 
 
Este condicionamiento para tener en cuenta el desarrollo en el suelo en el cual 
encontramos: 
La Zona denominada destapada es aquella zona plana a mínimo de las curvas de 
nivel por tal motivo el material de extracción no es muy llamativo para el propósito 
de la cantera teniendo en cuenta los beneficios económicos, tendrá un valor de 1 
punto. 
Zonas naturales  la cual se tenderá a ser evitada al máximo con el fin de generar 
menos impactos ambientales y costos o tener que recurrir a procedimientos 
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administrativos con la CAR4 que implique dilatar el proceso de extracción en el 
tiempo, este ítem tendrá un valor de 2 puntos. 
Las zonas de extracción son aquellas zonas en las cuales ya se hace extracción de 
material pero sin control de taludes, esto ha generado problemas de estabilización, 
será evaluado con un valor de 3 puntos. 
La zona de deslizamiento a pesar de percibirla como algo no favorable en el caso 
de extracción de material se convierte en algo de beneficio para la cantera por hacer 
más fácil la extracción de material menos inversión y más beneficio con una valor 
de 4 puntos. 
 
Creación: ráster zonas naturales.  
Ruta:  
- ArcMap → Toolboxes → Conversion Tools  → To Raster → Feature to raster. 
- Input feature data → zonas_n.shp  

Field  → identif 
Output raster → suelos_ras  
Output cell size → 2 (tamaño de celda) 

Tipo: modelo raster  
Descripción: convertir las poligonales de los tipos de suelos en raster 
Proyección: Magna Transverse Mercartor. 
Archivo: suelos_ras.shp 

 
Creación: Generación reclasificación suelos_ras.  
Ruta:  
- ArcMap → Toolboxes → Spatial Analyst Tools  → Reclass → Reclassify. 
- Input raster→ suelos_ras.shp  

Output surface raster → suelos_rec.shp 
 
Puntuación  Tipo suelo 

1   Destapada 
2   Natural 
3   Extracción 
4   Deslizamiento 

 
Tipo: modelo raster  
Descripción: generar una puntuación acorte con el estado de los suelos para tener 
una perspectiva frente a la generación de costo beneficio (Figura 16). 
Proyección: Magna Transverse Mercartor. 
Archivo: aspec_rec.shp 

 

                                                
4 Corporación Autónoma Regional 
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Figura 16. Fuente propia, reclasificación de la capa suelos. 

 
 
Algebra de Mapas con las zonas naturales. 

 
A lo largo del análisis anterior creamos un algebra de mapas y un capa de suelos 
con una resolución igual entre ellas. Ahora se puede comparar los valores de 
manera coherente en la nueva capa (Figura 17), nuestras capas para el nuevo ráster 
clave en el análisis de álgebra de mapas serán: 
 
Algebra de mapas:  solución_1 
Zonas naturales:  suelos_Rec 
 
Esto genera un nuevo algebra de mapas que permite determinar cuáles serán las 
zonas de menor o mayor inversión cumpliendo los parámetros geotécnicos.  
 
 
Creación: Algebra de mapas.  
Ruta:  

- ArcMap → Toolboxes → Spatial Analyst Tools  → Map algebra → Raster 
Calculator. 

- Input raster→ solucion_1 + suelos_rec  
Output surface raster → solucion_2.shp 

Tipo: modelo raster de elevación 
Descripción: combinar las dos capas con el fin que nuestros pixeles sean sumados 

y obtener, así, las zonas más propicias para iniciar la adecuación de taludes. 
Teniendo en cuenta la geotecnia y la estado de suelo actual. 
Proyección: Magna Transverse Mercartor. 
Archivo: solución_2.shp 
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Figura 17. Fuente propia, algebra de mapas de las capas solución 1 y suelos rec 

 
Al realizar nuestra algebra de mapas contamos con los siguientes valores  
 

 
Figura 18. Fuente propia, combinación de archivos solución 1 y suelos rec, y el nuevo archivo ráster con un degradado 
de píxel que oscila entre 4 y 10 clasifica la cantera mediante unidades de valor potencial para adecuación de taludes.  

 
Combinando estas dos capas con el fin que nuestros píxeles sean sumados y 
obtener, así, las zonas con mayor valor, estas zonas corresponden a los lugares 
donde los valores de píxel de cada una de las variables analizadas sean máximos 
su valor será igual a 10 (Figura 18) tal como lo muestra la gráfica anterior.  
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6. RESULTADOS 

 
 

6.1 DESCRIPCIÓN DE RESULTADOS 

 
Se genera la cartografía:  
Mapa geológico regional a la Cantera la Estrella, Mapa de las unidades 
Geomorfológicas en inmediaciones a la cantera la estrella y el Mapa de las unidades 
litológicas dentro del área (Tabla 2) de concesión de la cantera. 
 

 

 

 

 ORIGEN BOGOTA ORIGEN WGS84 
Decimales 

 Gauss Krueger Elipsoidal 

Punto Norte Este Norte  Este Norte Este 

1 963351.6036 1256661.034 4°15'50.384" 74°46'10.739" 4.263996184 -74.76955019 

2 963351.6036 1262339.492 4°15'50.384" 74°43'7.036" 4.263996184 -74.71862108 

3 960511.4196 1256661.034 4°14'18.559" 74°46'10.739" 4.238488376 -74.76955019 

4 960511.4196 1262339.492 4°14'18.559" 74°43'7.036" 4.238488376 -74.71862108 
Tabla 2. Coordenadas de las unidades geomorfológicas en inmediaciones a la cantera la estrella 

 
 
Mapa geológico regional a la Cantera la Estrella. 
 

 
Figura 19. Fuente  propia, Mapa geológico regional a la Cantera la Estrella (cuadro morado). 

 

Los municipios de Girardot y Ricaurte, geográficamente se ubican en el Valle superior del 

Magdalena, que recorre sobre sucesiones detríticas depositadas en ambiente marino 
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transicional  continental, presentando hacia la base dos niveles de liditas silíceas del miembro 

inferior y superior del grupo Olini (Kol). 

 

Desde el Mioceno tardío al Plioceno, estas sucesiones fueron deformadas debido al 

levantamiento de las cordilleras Central y Oriental, afectándolas compresivamente, 

generando dos frentes de cabalgamiento  convergencia al Este y Oeste (Gil, 2007), con  

sinclinales y anticlinales de ángulos de buzamiento bajos y ejes ampliamente separados, 

asimétricos  (Ingeominas, 2001). Localmente en la cantera La Estrella aflora esta unidad. 

 

Sobre ambas unidades descritas (Figura 19), reposan depósitos de terrazas fluviales (Qt),  

flujos torrenciales  y movimientos gravitacionales (Qd), compuestos por el retrabajamiento 

y fragmentación de los cuerpos rocosos Cretácicos y Neógenos. En la cantera La Estrella, un 

porcentaje importante de material a explotar, es de un coluvión, generado por la reactivación 

reciente de un proceso de inestabilidad en la ladera (VINASCO LARGO & NIETO 

LAGUNA, 2016). 

 
 
Mapa de las unidades Geomorfológicas del municipio de Ricaurte en 
inmediaciones de la cantera la estrella.  
 

En general los terrenos adscritos al municipio de Ricaurte, se caracterizan por presentar 

cuatro (4) unidades geomorfológicas (Figura 20). 

 
Unidad A: Morfología montañosa, cuchillas alargadas, patrón de drenaje paralelo, de 

pendiente alta  a moderada debido a la variación de los niveles silíceos arenosos con los 

silíceos lodosos del Grupo Olini (Kol; Foto 3). Genéticamente se le atribuye al tectónismo 

compresivo, responsable del levantamiento de las cadenas montañosas de los Andes 

Colombianos. 

 
Unidad B: Morfología de pie de monte, ondulada, convexa; genéticamente se le atribuye a 

depósitos de origen torrencial y gravitacional del cuerpo rocoso que compone las cadenas 

montañosas,   presentando en  algunos sectores cárcavas (Foto 3). 

 
Unidad C: Morfología de pendientes bajas, ondulada, cóncava y convexa, genéticamente se 

le atribuye a la depositaciòn detrítica de origen fluvial, correlacionándose con las 

sedimentitas del Grupo Honda (Th; Foto 4). 

 
Unidad D: Morfología de llanura, plana, corrientes meandricas, truncadas y abandonas 

naturalmente y por acción antrópica, ya que  algunos sectores de las poblaciones de Girardot 

y Ricaurte, se construyeron sobre esta unidad (foto  4). Genéticamente se le atribuye a llanura 

de inundación que forma la desembocadura del Rio Bogotá y el río Sumapaz, al Rio 

Magdalena. 
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Foto 3. Fuente  propia, panorámica de las unidades geomorfológicas A,B y C, costado SW de la cantera la estrella, sobre 
la  doble  calzada Flandes, El paso en el Kilómetro 7 + 350. 

 

 

 
Foto 4.  Panorámica de las  cuatro unidades  geomorfológicas  A, B, C,  D, desde la cantera la estrella 

 

 

La explotación de recebo en la cantera La Estrella, se realiza sobre las unidades A y B, por 

lo que se caracteriza y modela geotécnicamente el sistema de explotación; los principales 

procesos son la erosión superficial del derrubio y el socavamiento del macizo en la base del 

talud. Cronológicamente el proceso de inestabilidad de la ladera, tuvo varios eventos de 

inestabilidad, generados inicialmente de forma natural y posteriormente por la actividad de 

extracción. 
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Figura 20. Mapa de las unidades Geomorfológicas del municipio de Ricaurte en inmediaciones de la cantera la estrella. 

 

 

Unidades Litológicas dentro en el área de la cantera.  
 
El macizo rocoso donde se explota el recebo en  la cantera La Estrella, la compone liditas 

hacia la parte sur del área de la concesión y la parte NE de la cantera contigua (Foto 5). 

 
Se observa una variación en sentido Sur a Norte del área de concesión, un deposito más 

antiguo (Qd1), ubicado en el extremo NNW y otro (Qd2) reactivo hacia la zona centro – sur 

del área de concesión, siendo esta de interés para la explotación de recebo y material, 

caracterizado para realizar el análisis de estabilidad  de los bancos de explotación. Reactivado 

por la actividad antrópica, a inicios de la explotación de la cantera en sector SSE (Figura 21). 

 

 
Figura 21. Fuente  propia, Mapa de las unidades litológicas dentro del área de concesión de la cantera. 
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A escala de afloramiento, la formación varía de color con tonalidad crema, blanca a naranja 

(abigarrado), producto de la exposición a la intemperie. Esta consecuencia se describe 

formalmente, según Gil (2007), como Liditas (miembro inferior Kol 1) 

 

 

 

Foto 5 Fuente propia, bancos de explotación reactivados por la actividad antrópica 

 

Análisis espacial de los parámetros geotécnicos (Mapa Algebra de Mapas de 
capas ráster solución 1). 
 

Se genera Algebra de Mapas (Figura 22), en respuesta a la inestabilidad de taludes 
y manejo sin orientación de los mismos; este algebra de mapas contiene 
información de las zonas más adecuadas para iniciar el trabajo de taludes de la 
cantera la estrella;  luego se combina con elementos económicos para determinar 
cuáles serán las líneas que deben ser tenidas en cuenta al momento de iniciar la 
extracción y adecuación de taludes.  
 

Este plano da muestra de los parámetros geotécnicos a seguir para la orientación 

de los taludes en la cantera la estrella. 
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Figura 22. Fuente propia, algebra mapas, siguiendo los parámetros del análisis geotécnico solución 1. 

 

El análisis espacial de la capa solución_1 (Figura 22) se presenta de forma 

cuantitativa en cuanto a los parámetros que hemos combinado dos capas de 

entrada la de orientación y orientación de pendientes, en donde nos muestra como 

resultado la posición, superficie, la distancia y la interacción a través del propio 

espacio teniendo un sentido al poder tener esta información referenciada 

espacialmente.  

Las operaciones que se desarrollaron para el análisis de los datos espaciales es a 

partir de un conjunto de operaciones en base a los datos generados desde la 

geotecnia.  La Herramienta SIG nos permite hacer estos análisis de manera 

novedosa y ágil para cumplir los requerimientos técnicos de trabajo en el área de la 

cantera la estrella.  

Análisis espacial de los parámetros geotécnicos (Mapa Algebra de Mapas de 
capas ráster solución 2). 

 
La herramienta de análisis espacial que se ha utilizado para estudiar los datos 
geográficos es el álgebra de mapas, en este plano (Figura 23), podemos hablar de 
un análisis de valores cuantitativos y cualitativos de las capas solución_1 y 
suelos_rec, los  cuales permiten hacer mucho  más específico el propio análisis 
desarrollado anteriormente, teniendo en cuenta aspectos de factor económico que 
representan gran importancia en este tipo de procesos.  
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Figura 23. Fuente propia, algebra mapas, siguiendo los parámetros del análisis geotécnico solución 2. 

 
 
Los planos de solución_1 y solución_2 nos dan respuesta a los planteamientos 
previos, dando respuesta a las preguntas acerca de los datos y los procesos 
espaciales. Se conoce bien las cuestiones planteadas de los estudios geotécnicos 
y cuál es la solución a estos, la solución se da desde la relativa posición y extensión 
de los datos, su forma y distribución, su interacción espacial y la variación producida 
al relacionarla con otros datos que resultan relevantes para la actividad en la 
cantera. 
 
 
 
A través de la mera  representación de los datos geográficos, el SIG puede ayudar 
a identificar y dar respuesta  a los interrogantes, las soluciones dadas para la 
cantera la estrella son patentes con el simple análisis visual. Esto da muestra de la 
efectividad de los algoritmos de análisis geográfico en SIG para explotar en 
profundidad de la información espacial. 
 
Este análisis de superficies es uno de los más potentes encontrados en un SIG 
(Víctor Olaya, 2011)  desde parámetros básicos como la pendiente y la orientación. 
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6.2 DISCUCIÓN DE RESULTADOS. 

 
Los resultados obtenidos brindan información confiable, dado que el modelo ráster 
hace énfasis en aquella característica del espacio que analizamos de la topografía 
obtenida en campo (Anexo E. cantera_estrella_tamaño _0.7x0.5) y los análisis 
desde la geotecnia (VINASCO LARGO & NIETO LAGUNA).  

 
Se empezó por el modelo conceptual dado desde la geotecnia, el punto de vista 
cinemático propone los taludes no pueden tener orientaciones en el rumbo entre 
N60E a N30W buzando hacia el NW como hacia el NE, con ángulo de buzamientos 
mayores de 65° grados. 
 
El modelo de representación a partir de capas ráster, La regularidad y sistematicidad 
de las mallas hacen sencillo el implementar algoritmos de análisis, muy 
especialmente aquellos que implican el uso combinado de varias capas. Cuando 
estas capas están en formato ráster y existe coincidencia entre sus mallas de 
celdas, el análisis conjunto de estas resulta inmediato (Víctor Olaya, 2011). De esta 
manera las capas slope_rec (pendientes) y aspec_rec (orientación de pendientes) 
cumplen estos requisitos para desarrollar el álgebra de mapas. 
 

La codificación se realiza mediante el álgebra de mapas, se calculó funciones 

locales, asignando valores a una celda en base a los valores que esa misma celda 

presenta para cada una de las capas de entrada, operando con estos de una forma 

u otra. Es decir, el valor resultante para una localización dada es función 

exclusivamente de lo que se encuentra en dicha localización, no dependiendo en 

modo alguno de otras localizaciones (otras celdas) (Víctor Olaya, 2011). 

 

Figura 24. Fuente (Víctor Olaya, 2011). Funciones de análisis local 
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Las funciones de análisis local analizan los valores de una celda concreta en una 

serie de capas para obtener el valor resultante (Figura 24). En rojo, celdas de 

partida analizadas. En verde, Celda que recoge el resultado. 

 

De esta manera se ha generado la capa solución_1 teniendo en cuenta las 

pendientes y orientación de pendientes desde la geotecnia (Figura 25), nos da 

como resultado las zonas geográficas más adecuadas para iniciar la labor de 

extracción de materiales, se debe tener en cuenta que los valores mayores (6) 

representan las zonas de extracción y adecuación de taludes más favorable. 

 

Figura 25. Fuente propia, zonas adecuadas para las zonas de banqueo. 

 
La idoneidad de los datos realizados en el álgebra de mapas para el análisis de 
taludes esta dado al minimizar el espacio ocupado por los datos y maximizar la 
eficiencia de cálculo. De esta manera se ha generado la capa solución_1 teniendo 
en cuenta las pendientes y orientación de pendientes desde la geotecnia, nos da 
como resultado las zonas geográficas más adecuadas para iniciar la labor de 
extracción de materiales, se debe tener en cuenta que los valores mayores (6) 
representan las zonas de extracción y adecuación de taludes más favorable  (Figura  
26). 
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Figura 26. Fuente propia, Ráster vs puntos, mapa de algebra capa solución 1. 

 
La codificación realizada a partir del algebra de mapas5 en la capa geográfica 
solución 1, se observa con 6 puntos donde se encuentra la mayor parte de celdas 
10.262 (Tabla 3), esto nos indica que puede adecuar una zona (41048 m²) en el 
manejo de taludes tal como lo indica la geotecnia. 

 

 
Tabla 3. Atributos de la capa solución 1. 

 
  

                                                
5 La información contenida en las capas es susceptible de ser analizada para la obtención de otras capas 

referentes al mismo espacio geográfico, pero que contengan distinta información derivada de aquella. Y 

extraer nuevos valores a partir de los contenidos en una o varias capas. 

427 2.

1 990 3.

8 781 4.

879 5.

10 262 6.

Solución 1

Puntos

2. 3. 4. 5. 6.

R
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11 000

10 000

9 000

8 000

7 000

6 000

5 000

4 000

3 000

2 000

1 000

0

427 2.

1 990 3.

8 781 4.

879 5.

10 262 6.
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El álgebra de mapas en la capa solución 2, nos permite tener en cuenta la influencia 
de los suelos en los costos sin necesidad de determinar un valor económico directo 
de las zonas (Figura 27), pero si teniendo en cuenta el estado del suelo actual para 
hacer las labores de taludes en la cantera.  
 

 
Figura 27. Fuente propia, zonas adecuadas para las zonas de banqueo, solución 2 

 
Generando la capa solución_2 teniendo en cuenta las pendientes, orientación de 
pendientes (desde la geotecnia) y zonas naturales (suelos), nos da como resultado 
las zonas geográficas con un mayor o menor costo en el desarrollo de la estabilidad 
de taludes para extraer los materiales de cantera, se debe tener en cuenta que los 
valores mayores (10) representan las zonas de extracción más seguras y 
económicas. 
 

Con las orientaciones actuales de los cortes mineros y para la geometría propuesta 

en el diseño final, teniendo en cuenta taludes con altura de 10 metros, ancho de 

bermas de 8 metros e inclinación de 45º, no se encontraron factores de seguridad 

inferiores a uno, inclusive para los escenarios de condiciones extremas, es decir 

con sismo y lluvia, por lo cual es viable implementar dicha geometría, dando 

cumplimiento a lo establecido en los términos de referencia entregados por las CAR. 

(LAZO BELTRÁN, 28 agosto 2010). Con los anteriores datos se garantiza la no 

desestabilización del terreno, además de tener en cuenta que los taludes no son 

altos ni con pendiente. 
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Figura 28 Fuente propia, Ráster vs puntos, mapa de algebra capa solución 2. 

 

La codificación realizada a partir del algebra de mapas la capa geográfica solución 

2, se observa con 10 puntos (Figura 28), donde se encuentra con un valor de celdas 

2352, esto nos indica que puede adecuar una zona (9408 m²) en el manejo de 

taludes tal como lo indica la geotecnia. Se debe tener en cuenta que las zonas 

propias para el manejo de taludes son los valores más altos (Tabla 4).  

 

Tabla 4. Atributos de la capa solución 2 

Al comparar las capas solución_1 y solución _2, se puede observar un cambio 

gradual el en área inicial de manejo de taludes, esto es de gran beneficio al permitir 

ser mejor enfocada la zona de trabajo inicial, se ve favorecido en cuanto se cuenta 

cumpliendo con los parámetros desde la geotecnia y la favorabilidad de los suelos 

para extracción del material. 

89

1 353

5 549

2 404

6 380

4 212

2 352
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89
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6 380
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2 352
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La recopilación y generación de información permitió generar un mapa donde se 

puede localizar las zonas más idóneas para el trabajo de taludes (zonas de 

banqueo), como también contar con el desarrollo de una herramienta base SIG, que 

genera información confiable para la cantera la estrella. Facilitando la toma de 

decisiones y posibles medidas de gestión frente al avance de extracción de material. 
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7. CONCLUSIONES 

 
 

 La explotación de recebo en la cantera la Estrella se realiza sobre las unidades 
geomorfológicas A y B, genéticamente moldeadas por el tectonismo6 regional y 
procesos denudacionales7. 
 

 Los principales procesos a los que se debe actuar es a la erosión superficial del 
derrubio y al socavamiento del macizo en la base del talud, resaltando que 
cronológicamente el proceso de inestabilidad inicialmente se dio de forma 
natural y posteriormente reactivo por la actividad antrópica tal como se muestra 
en la capa solución_2. 

 

 El análisis cinemático para las familias de discontinuidades, sugiere direcciones 
críticas entre N60°E Y N50°W con inclinaciones superiores a los 65° buzando 
hacia el Norte o Sur, los cuales son propensos para roturas de tipo planar, cuña 
y volcamiento.  

 

 La extracción de material se puede realizar teniendo en cuenta la capa 
solución_1 ó la capa solución_2 de acuerdo a los valores más altos resultados 
en el álgebra de mapas. 

 

 La información generada por el estudio SIG es confiable para el desarrollo de 
manejo y diseño de las zonas de banqueo. 

 

                                                
6 Es el conjunto de movimientos de gran magnitud que afectan la corteza terrestre y provocan que las capas 

rocosas se deformen, rompan y reacomoden.  
7 Geol. Desprendimiento o desaparición de la parte más externa de la corteza terrestre a causa de la erosión. 
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8. RECOMENDACIONES 

 
 

 Ampliar el área de la concesión minera para garantizar la calidad del material 
de interés económico y el desarrollo del modelo geotécnico propuesto y 
verificado en la presente investigación. 

 

 Dados los parámetros geotécnicos (Alfonso Lazo Beltran. , 2010) descritos 
en campo y medidos mediante ensayos de laboratorio, se sugiere la 
conformación de los nuevos taludes (Sistema de Banqueo) con las siguientes 
dimensiones. 
Altura de talud 10 m. 
Ancho de berma 8 m. 
Ángulo del talud 45°. 

 

 Comenzar a realizar el manejo de taludes en las zonas indicadas por los 
análisis realizados en el SIG. 

 

 Establecer labores de rehabilitación ambiental para reducir en el tiempo el 
impacto paisajístico y biodiverso del área de explotación. 

 

 En cuanto a las bermas estas tendrán una pendiente entre el 2 y el 3% hacia 
adentro, con el fin de interceptar las aguas lluvias e impedir que discurran por 
la cara del talud, las cuales caerán a unos canales o cunetas colectoras 
localizadas al pie de los taludes. Las dimensiones de las cunetas con base 
al análisis hidrológico son: 40 cm de ancho en la parte superior, 30 cm de 
ancho en el fondo y 30 cm de alto. 
 

 Se establece como cota base a 420 m, será el punto de partida para el 
diseño. 
 

 Se deberá realizar una planificación a largo plazo, ya que le permitirá estimar 
los siguientes bancos y reservas a explotar. 
 

 Los frentes de explotación actuales de la cantera podrán ser utilizados como 
nuevos sitios de depósito de material de desalojo. 
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ANEXO 

 
 
Anexo A. Plano topográfico Noviembre 2005 pdf. 
 
Anexo B. Plano topográfico Octubre 2009 pdf. 
 
Anexo C. Restauración morfológica Abril 2010 pdf. 
 
Anexo D. Plano Município de Ricaure pdf. 
 
Anexo E. Cantera la estrela. Plano topográfico pdf. 
 
Anexo F. Cartografia Geologia Regional pdf. 
 
Anexo G. Cartografia Geologia Local pdf. 
 
Anexo H.  Cartografia geomorfológica superfície pdf. 
 
Anexo I. Plano topográfico perfiles pdf. 
 
Anexo J. Resumen Análitico. 
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ANEXO J 

RESUMEN ANALÍTICO 

 
 

Título del proyecto CARTOGRAFÍA Y ANÁLISIS DE TALUDES EN 
LA CANTERA LA ESTRELLA, UTILIZANDO 

SISTEMAS DE INFORMACIÓN GEOGRÁFICA. 
 

Presidente Jorge Iván Carmona Chica 
jorgeivancarmona@hotmail.com 
Licenciado en Educación ambiental 

Tipo de documento Trabajo de grado 
Referencia documento CARMONA, Jorge. Cartografía y Análisis de taludes 

en la cantera la estrella, Utilizando sistemas de 
información  Geográfica. Manizales, 2016, paginación 
o número de volúmenes. Designación de trabajo de 
grado (título académico). Universidad de Manizales. 
Facultad de ciencias e Ingeniería. Sistemas  de 
información Geográfica. 

Institución Especialización en Sistemas de Información 
Geográfica, Faculta de ciencias e Ingeniería, 
Universidad de Manizales. 

Palabras claves Proyección, cantera, taludes, pendiente, minería, 
algebra de mapas, pixel. 

Descripción Trabajo realizado con el fin de determinar las zonas 
más adecuadas en el manejo de taludes de acuerdo  
a los parámetros dados por la geotecnia. 

Fuentes Información recogida en trabajo de campo.  
Tesis de estudio geotécnico de la cantera. 

Contenido Recolección de datos. 
Generación de capas ráster mediante algebra de 
mapas. 
Análisis de datos generados. 

Metodología Método  descriptivo 
Método exploratorio 

Conclusiones  El análisis cinemático para las familias de 
discontinuidades, sugiere direcciones críticas entre 
N60°E Y N50°W con inclinaciones superiores a los 65° 
buzando hacia el Norte o Sur, los cuales son 
propensos para roturas de tipo planar, cuña y 
volcamiento, el álgebra de mapas nos permite dar 
solución a los parámetros geotécnicos. 

Anexos Anexo A. Plano topográfico Noviembre 2005 pdf. 



 

61 

 

Anexo B. Plano topográfico Octubre 2009 pdf. 
Anexo C. Restauración morfológica Abril 2010 pdf. 
Anexo D. Plano Município de Ricaure pdf. 
Anexo E. Cantera la estrela. Plano topográfico pdf. 
Anexo F. Cartografia Geologia Regional pdf. 
Anexo G. Cartografia Geologia Local pdf. 
Anexo H.  Cartografia geomorfológica superfície pdf. 
Anexo I. Plano topográfico perfiles pdf. 
Anexo J. Resumen Análitico. 

 
 


